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A few years ago, Walt Ord-

way gave us a presentation 

on HDTV and a year later 

gave us a presentation on 

Digital Cinema. Well, Walt 

will be coming to our Octo-

ber 6th meeting to give us an 

update on HDTV. We are 

getting closer to the magic 

date of February 17, 2009, 

which will be the last day of 

analog television in the 

USA. So, Walt's current 

presentation will give us a 

quick overview of the origi-

nal FCC announcement 

about HDTV and that ana-

log TV would end on  

December 31, 2006. Then 

he'll tell us what happened 

and why it got changed to 

February 17, 2009. He will 

give us more info about 

which of us will be and 

which of us won't be af-

fected. He will also tell us 

what we need to do if we 

fall in the category of ―being 

affected.‖  

 

Since his presentation will 

be on October 6, 2008, he 

will also be able to tell us 

about an analog to digital 

TV conversation in a city in 

North Carolina on Septem-

ber 8, 2008. 

 

As a little side line, Walt 

will also give us some info 

about HD radio. 

 

So, if you want to get the 

latest word on HDTV, make 

sure you're at the October 

meeting. 

Work is either fun or drudgery. 

It depends on your attitude. 

 

--Colleen C. Barrett, 

president emeritus of  

Southwest Airlines 

 

October 6th 
HDTV Transition 

Almost Here 
With Walt Ordway 
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GENERAL MEETING 

General meetings are held at 7:30 p.m. on the first 

Monday of the month at the Salvation Army Facil-

ity, 4223 Emerald Street (at the corner of Emerald 

and Earl Streets), Torrance. 

Greater 
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PC Users Group 

A member of 

Association of Personal Computer User Groups 

 

 

 

 

 

 

 

 

 

MEMBERSHIP 
Membership is available for twelve months from the 

date of  joining. Membership rates: 

 

 Individual  $36.00 

 Student  $18.00 

 Family  $48.00 

 Newsletter Subscription  $18.00 

 

Checks payable to GS-BUG, Inc. 

Mail to: 

GS-BUG, Inc. — Membership 
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to the author and the original publication. 

 

SUBMISSIONS 
All submissions to the GS-BUG Report must be un-

formatted on PC disk or e-mail (no hardcopy). Limit 

formatting to bold or italicizing. We reserve the 

right to edit as necessary for space consideration. 

Art work submitted must be in a common graphics 

format (.jpg, .tif, etc.) 

 

DISCLAIMER 
All opinions herein are those of the individual au-

thors only, and do not reflect the opinions of GS-

BUG, Inc. The group does not intend to endorse, 

rate or otherwise officially comment on products 

available and readers are cautioned to rely on the 

opinions presented at their own risk. 

 

Articles are compiled without verification of accu-

racy or application to a special task or computer. GS

-BUG, Inc., its contributors and the editor do not 

assume any liability for damage arising out of the 

publication or non-publication of any advertisement, 

article, or any other item in this newsletter. 

BOARD OF DIRECTORS 
 

President Garry Sexton 310-373-3989 

  uags@aol.com 

 

Vice-President Tom Tucknott 310-530-4992 
  ttucknott@socal.rr.com

  

Secretary   

 

 

Treasurer Jim Corones 310-322-1441 

  jcorones1@juno.com 

 

Librarian  

 

 

Membership Patrick Garvey 310-378-9767   

  Membership.GSBUG@gmail.com 

 

Program  

 

 

Web Master Shelley Miller 310-541-6796 

  seamil19@verizon.net 

 

Past President Emmett Ingram  310-377-4668 

 

Directors at Large 
John Hanson 310-643-9882 

 ba030@lafn.org   

 

Virginia Pfiffner  310-374-2410 

  vpfiffne@elcamino.edu 

 

Greg Neumann  Gbug_caller@aol.com 

   

Newsletter Staff 
Editor Marian Radcliffe 818-249-1629 

 MarianRad@1stNetUSA.net 

 

Proofreader  Virginia Pfiffner 

 



 October 2008 http://gsbug.apcug.org Page 3 

President’s Thoughts 

 

By U. A. Garred Sexton 

The efforts that some of the people that present to 

us will go to in order to fulfill the promise to give 

us a program are impressive. 

 

I was going to be out of town at the time of our 

September meeting so to be sure everything 

would work, because this was not our regular 

meeting night, I contacted the Salvation Army 

and was assured that the meeting room was avail-

able. After I left town, there was a call at home 

on the answering machine that there was an  

error, the room was not available.  

 

Tom Tucknott did not get this information so he 

and our speaker showed up at the Salvation 

Army to discover there was no place to have the 

meeting. Robin Ziegler, from Google, was in-

formed that neither the room nor Internet access 

were available but he said he had a way of get-

ting on line. 

 

To Plan B –  it was decided to go to my home 

where Internet access would be available. So the 

operation moved to my house only to discover 

that no one knew the code to sign on to the WiFi.  

 

At that point Robin Ziegler used his phone card 

to get on the Internet and proceeded to make an 

outstanding presentation that was received with 

rapt attention by the members attending. The 

amount of effort put forth on his part is an exam-

ple of the above. 

 

Boy, talk about going above and beyond the call 

of duty! 

 

October will be a busy month – we will have an 

election of officers and a special SIG presenta-

tion by Harold Pfiffner at Sexton‘s house. If the 

SIG runs out of time it will continue on another 

Thursday night.  

 

Unfortunately, by the time you get this news let-

ter the SIG will have occurred. The reminder 

about the SIG was to be sent out by Email. If this 

does not work for you let me know. 

Although a small, intimate room probably won't 

accommodate a 50-inch HDTV, you don't have 

to give up on your dream of having a wide 

screen TV in your 12- x 12-foot bedroom or 

family room.  

 

Consider a flat-panel LCD TV, which you can 

mount on a wall. Wall mounting saves at least 12 

inches of space that you'd usually lose when you 

have a bulkier CRT (cathode-ray tube) TV, not 

to mention the space the TV stand itself usually 

takes up.  

 

And because you can sit closer to HDTVs than 

you could to analog sets (the closer you sit to an 

analog TV, the more horizontal scan lines your 

eyes detect), you can actually put a good-sized 

screen in a small space. 

TV Placement In Small Spaces 
 

From Smart Computing 

Tip 
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Internet Talk 

By Frank Chao 

Member, GS-BUG 

This is the 108th Internet Talk 

article for The Bug Report, a 

publication of the Greater South 

Bay PC Users Group (GSBUG).  

Liz and I are now active in the 

Tucson Computer Society. Their 

Web site is at www.aztcs.org. 

We will use what we learn from 

these folks to provide you with 

future articles in this series. 
 

TUCSON COMPUTER SOCI-

ETY WEB PAGE 

 

The Tucson Computer Society 

publishes a Meeting Notes page 

at 

http://www.aztcs.org/

meeting_notes/

meeting_notes.shtml 

On this page, you will find hy-

perlinks to Adobe Acrobat PDF 

documents that contain informa-

tion from some of their meetings. 

Some recent subjects include: 

 

Identity Theft 

Accessing Libraries Online 

Training for Digital Photography 

and  

All About Linux 
 

 

FINDING OWNERS  

MANUALS  

 

If you are looking for an owner‘s 

manual for a car, a home appli-

ance, a camera, a computer, or 

just about anything, start your 

search at the manufacturer‘s 

website.  

 

Look for a section called 

―Support‖ or ―Owner's manuals‖ 

or ―Documentation.‖ 

 

If the manufacturer‘s website 

does not have the manual, try 

―diplodocs.com‖ at 

http://safemanuals.com. 

Finally try searching at Google 

by putting in the name of the 

manufacturer followed by the 

model number or model name. 

 

LABELING COMPUTER  

CABLES 

 

During the month of August, Liz 

and I helped several nice folks 

with their computers and about 

half of the problems that we re-

solved were caused by incorrect 

cable connections. 

 

Here is a typical scenario: your 

kid dismantles your computer 

and/or its broadband modem 

while cleaning. He then puts it 

back together with one or more 

cables inserted incorrectly. Now 

your computer can‘t reach the 

Internet and you are now consid-

ering phoning the Geek Squad to 

visit you for $169+ for the first 

hour.  

 

Now, let‘s back track. Think 

about how you could prevent this 

predicament in the first place. 

You need to label all of the ca-

bles that connect your computer 

to your network equipment.  

 

Being tightwads, Liz and I label 

all our computer cables with a 

permanent ink marker and dull, 

writable Scotch tape. Some of 

our friends at the Tucson Com-

puter Society use a Brother label 

maker, which is a bit pricey, but 

the labels are a lot better looking 

than ours. 

 

If you use a Dymo label maker, 

you will have to use super glue to 

stick the labels on permanently, 

since the lame adhesive they use 

eventually dries out and causes 

their labels to fall off.  

 

Liz and I sometimes use a per-

manent ink pen to write on the 

exterior of a cable in order to 

avoid having to create a label. 

This works well for grey or white 

colored cables but is not feasible 

for black colored cables. 

 

ENTRY-LEVEL BROADBAND 

 

At the entry-level of broadband 

Internet, ―Asynchronous Digital 

Subscriber Line‖ which is also 

known as ―ADSL‖ or ―DSL‖ 

continues to be cheaper than  
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cable modem or satellite dish 

Internet. Let me illustrate this 

with some local examples: 

 

DSL EXAMPLE: AT&T 

 

If you go to http://www.att.com 

and click on ―Internet‖ and put 

in the North Torrance Zip Code 

of 90504, and then click on the 

―Internet & DSL‖ button, you 

will be offered  ―Basic DSL‖ 

service for $14.99. If you click 

on this offer, you will find that 

they promise not to raise the 

price for 2 years: 

 

CABLE INTERNET EXAM-

PLE:  TIME WARNER 

 

If, instead, you go to 

www.timewarnerla.com/

pricingGuides/PDFs08/1050-PL

-0208.pdf you will find that the 

lowest cost option is $34.95 per 

month for a resident of the Tor-

rance area. 

 

Note that both choices are ex-

actly the same. At $35 per 

month, Time Warner's per-

month price for the lowest speed 

of cable modem Internet in 

North Torrance has been about 

the same for about 4 years. 

 

SATELLITE INTERNET  

OPTION: DISH NETWORK 

 

Now, let‘s us go to Dish Net-

work‘s Website at 

www.dishnetwork.com. 

Click on ‗Shop,‘ then click on 

‗Internet.‘ Finally click on 

‗Satellite Internet.‘ 

 

You will discover that  the low-

est level of satellite Internet ser-

vice costs $49.95 per month. 

BOTTOM LINE AGAIN:   

DSL IS THE CHEAPEST 

 

The above examples illustrate 

the following rule-of-thumb: 

At the lowest, entry-level of 

broadband service: DSL is 

cheaper than cable modem 

which is cheaper than satellite. 

 

Some GSBUG members have 

stated to me that they can justify 

spending the extra money for a 

cable modem or a satellite dish 

connection because they are 

three or more times faster than 

entry-level DSL service.  

 

However, if you are new to fast, 

broadband Internet and all you 

have ever had is a dial-up mo-

dem connection at 56 kilobits 

per second, you probably will 

not appreciate the faster speed of 

entry-level cable or satellite, and 

you will probably prefer the 

lower price of DSL . At least 

that is what several GS-BUG 

and several Tucson Computer 

Society members have told us. 

 

Liz and I generally recommend 

that new broadband users sign 

up for entry-level ADSL service 

instead of the pricier cable mo-

dem service. If you win the lot-

tery, you can always upgrade to 

a pricier, faster service option! 

 

TWO DSL HOOKUPS FOR 

REDUNDANCY 

 

Two  GS-BUG members have 

also stated that because entry-

level ADSL is cheaper, they 

chose to put two ADSL connec-

tions into their homes for redun-

dancy for a lower total price 

compared to the monthly cost a 

single cable modem or satellite 

Internet hookup.  Here is how 

this works: 

 

For each phone line in your 

home, you order a unique DSL 

connection for about $15 per 

month. Hence, if you have two 

phone lines at your home, you 

can order two ADSL connec-

tions for a total of $30 per 

month. Then you would connect 

some of the computers in the 

house to one of the ADSL con-

nections and other computers are 

then connected to the other 

ADSL connection. If one Inter-

net connection fails for any rea-

son, then you can re-route all of 
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its associated computers to the 

ADSL connection which is still 

operational. Of course, when the 

ADSL provider has a total outage 

in your residential area, then both 

of your ADSL connections will 

fail. 

 

DIAL-UP MODEMS FOR A 

BACKUP 

 

Liz and I continue to recommend 

that you use a dial-up modem for 

a backup when your broadband 

Internet connection fails. We 

continue to use the free versions 

of NetZero and Juno and the dial

-up version of the Los Angeles 

Free-Net as a backup connection 

to the Internet whenever our ca-

ble modem connection has an 

outage. 

 

Since moving to Tucson in 

March, we have reverted to a dial

-up connection four times when 

our cable modem service had 

outages. On all four occasions 

we were pleasantly surprised at 

how easy it was to attach a USB 

56-kilobits per second modem to 

a computer and run the ‗Connect 

To‘ wizard to get Windows to 

make a dial-up connection to the 

Internet. 

 

 

SOME WEB SITES ARE ―PUT-

ONS‖  

 

When browsing the Internet, 

please be aware of the fact that 

some Web sites are satirical and/

or humorous and/or malicious 

―put-ons.‖  

 

Go to http://

blackpeopleloveus.com 

No where at this web site do they 

disclose that this entire site is a 

satirical ―put-on.‖  All of the per-

sons in this site are actors. This 

web site is a creation of Chelsea 

Peretti, a professional comedian. 

Her web site is at 

www.chelseaperetti.com. 

 

When Liz and I first saw the 

―Black People Love Us‖ web 

site, we did not know what to 

make of it. We then went to 

Google and we searched on: 

―Black People Love Us wiki.‖ 

 

On the second page of ―hits,‖ we 

found the following Wikipedia 

page at http://en.wikipedia.org/

wiki/Chelsea_Peretti 

 

This Wikipedia page refers to 

―Black People Love Us‖ as satire  

 

and credits Peretti with creating 

it.  

 

At the above-mentioned Wikipe-

dia page,  we also found the link 

to Chelsea Peretti's Web page. 

 

If you have any questions or 

problems, I can be contacted by 

the following methods:  

 

1.  Send me e-mail at: 

fchao2@yahoo.com 

 

2.  Send ―snail‖ United States 

Postal Service (USPS) mail to 

 

     Frank Chao 

     405 E. Wetmore Rd. 

  #117-484 

     Tucson, AZ 85705-1792 

    

Or sell your computer and take 

up golf instead!! 
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Obtained from APCUG with the au-
thor's permission for publication by 
APCUG member groups. 
 

First, we must understand that 

photograph (image) size in the 

camera and in the computer is 

measured in pixels. These are the 

basic dots of color that make the 

picture. Do not pay any attention 

to anything that says ‗inches‘ or 

‗pixels per inch.‘ These terms are 

meaningless when we are consid-

ering a picture either in the cam-

era or in the computer.  

 

They may come into play later if 

we want to print the photo on 

paper. But, that is another subject 

for another time. For now, we 

think only of pixels.  

 

Most cameras record too many 

pixels to e-mail. For instance, a 6 

megapixel camera will make a 

picture about 3000 pixels wide 

by 2000 pixels tall and the file 

size may be several megabytes. 

Our screens are usually only 

about 1000 pixels wide (some are 

larger and some smaller). So, if 

we e-mail the native picture, it 

will be wider than the screen for 

the recipient and the file will be 

so large, it may take ―forever‖ to 

download to the recipient‘s com-

puter. It is possible the service 

provider will not even accept it. 

 

There are two things we must do 

to make a photo e-mailable. The 

first is to resize or resample the 

picture. We want to change the 

picture width from 3000 pixels to 

800 pixels, for instance. This 

process is called resizing or re-

sampling. We have to pick the 

best 800 pixels out of the 3000 to 

represent our photo. Well, no, 

that is not exactly correct but it 

simplifies things to think of it 

that way. We don‘t have to worry 

about it because a lot of very 

smart programmers have devel-

oped ways (algorithms) to help 

us. Just remember, you want to 

resize or resample to get the 

photo down to a size convenient 

for e-mailing. I usually use 800 

pixels or 900 pixels width for 

pictures I attach to e-mails. 

 

The second thing to do to make a 

photo e-mailable is to save it in 

JPEG format (.jpg). That is a 

format that reduces file size a lot 

and picture quality a little so the 

picture can be downloaded more 

quickly and still be nice to look 

at. Some software programs give 

you choices of compression 

amount with numbers ranging 

from 1 to 10. One will result in a 

very small file but the picture 

quality will not be good at all. A 

10 will give the very best quality 

but with a very large file size. A 

reasonable compromise is to use 

5 or 6. I usually use 6. 

 

How do you do this? First, I will 

describe how to do it with a free 

Microsoft program. Then I will 

try to look at some other pro-

grams. 

 

Microsoft Power Toys for XP 

has a Resize Pictures toy that is 

slick and easy but feedback says 

it only works on XP. It can be 

downloaded at . Right click on an 

image name or thumbnail in Ex-

plorer or My Computer and 

choose Resize Pictures. You are 

limited to four specific sizes but 

they are good choices. They 

don‘t tell us what compression 

they are using but the results 

look OK. Unless you tell them 

under Advanced to replace the 

image in the file, it will make a 

copy. That‘s good. They will add 

the word, ―Large‖, ―Medium‖ or 

―Small‖ to the end of the name 

you have chosen. 

If you are happy with this solu-

tion, then read no further.  

 

E-Mailing Photographs 
By Richard Kennon 

Amador Computer Users Group, CA 
www.acug.net 

Drtrdguy@volcano.net 

Article 
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But, if you want to use a picture 

editing program, maybe this will 

help. 

 

In Photoshop Elements 5, click 

on ‘Image>Resize>Image Size’ 

and this window will pop up. 

Note that there is some garbage 

at the bottom about ‗inches‘ but 

we will ignore that. First we will 

click the ‘Resample Image’ box. 

That puts the Pixel Dimensions 

in play and that is what we want. 

I selected the ‗Width‘ box and 

changed the width to 800 pixels. 

Since the ‘Constrain Propor-

tions’ box is selected, that is all I 

have to do.  

 

Note, down at the bottom, that 

we have several choices of sam-

pling algorithms. This is frosting 

on the cake. I read somewhere 

that I should use ‘Bicubic 

Sharper‘ when downsizing so 

that is what I do. Most programs 

don‘t give us all these choices. 

Then we should click on 

‘File>Save As’ and give the 

photo a new name. I often just 

use the same name and add 

‗_800px‘ so the next time I will 

know it is ready to e-mail. Here 

we can choose the JPEG format 

and the compression amount. 

Photoshop Elements 6 is out now 

and sells for about $100. If you 

are able to spend that much and 

want one of the best editing pro-

grams, I highly recommend it. 

 

Let‘s look at Picasa2. It is a free 

program from Google and looks 

really good but I do not have 

much experience with it. By all 

means, try it first because the 

price is right! When it comes to e

-mailing photographs, it is a little 

more automated but not any eas-

ier to use than Elements. First, 

click on ‘Tools>Options>E-

Mail.‘ Then select the width you 

want in pixels. There are six 

choices. Then click on ‘Apply’ 

and ‘OK.‘  

 

The next step is to click on 

‘File>E-Mail’ and you will get 

three choices of how you want to 

e-mail your photos. Fortunately, 

I use Outlook Express so my 

choice is listed. 

 

When I clicked on Outlook Ex-

press, an e-mail page popped up 

with the photo attached. At this 

point we can write something 

else on the e-mail and send it. I 

recommend this so the recipient 

will know it is really from you 

and not something sent out by a 

virus. When I receive e-mails 

that only say ‗Attached,‘ I delete 

them without looking at the at-

tachment. This saved me one 

time when I received a virus 

from my sister-in-law that she 

did not know she sent. She spent 

weeks and dollars getting her 

computer back up. Oh, I digress. 

If you want to send more than 

one picture (and, who doesn‘t?), 

you must select the picture and 

click on the ‗Hold‘ button near 

the bottom of the screen. Do this 

for each photo you want to send 

and they will all be attached to 

the e-mail. The program auto-

matically chooses JPEG format 

and a compression ratio but does 

not tell you. That is okay as the 

pictures I tried looked good. Pi-

casa2 has considerable capability 

for editing photos in many re-

spects. Try it! 

 

There are many other editing 

programs that I haven‘t men-

tioned and have no experience 

with. In all cases you want to 

change the picture‘s size in pix-

els by resizing or resampling. 

Pay no attention to anything that 

says ‗inches‘ as that will have no 

meaning for this process. Some-

time later we will talk about 

printing pictures and then we will 

use inches. 

 
This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above). 

(From Vista—Part 9, page 9) 

 

some that are free. I've been us-

ing the free version of Zone 

Alarm for many years and I'm 

satisfied with its protection. It 

also creates a log that I can use 

to examine attempts to connect 

to my computer. You can find it 

on the Internet at 

www.zonealarm.com. 

 
This article has been provided to AP-

CUG by the author solely for publica-

tion by APCUG member groups. All 

other uses require the permission of 

the author (see e-mail address above). 
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Obtained from APCUG with the au-

thor's permission for publication by 

APCUG member groups. 
 

As I mentioned last month, 

Vista's Service Pack 3 is out. I 

didn't see any real changes in 

my computer after I installed it, 

most of the modifications are 

supposed to deal with computer 

security. I have since encoun-

tered a problem with my printer. 

 

I don't print too often from my 

―Vista computer‖ so the problem 

wasn't immediately obvious. 

When I did try to print some 

documents they ―disappeared‖ 

without printing. My first 

thought was that I had changed 

the firewall on my print server 

and locked out connections from 

other computers on my home 

network (I've done that before). 

No that wasn't it. After checking 

and finding that I could transfer 

files between my computers, I 

went to the printer section of my 

control panel. That's where I dis-

covered that Vista wanted a new 

printer driver installed. I don't 

remember any problems with the 

printer when I started using this 

computer. As I recall, Vista rec-

ognized my printer (a fairly new 

HP ink jet printer) and it just 

worked. Anyway, a search of 

Hewlett Packard's web site did-

n't reveal a new printer driver. In 

fact it told me to use the one 

built into Vista. I turned to the 

installation CD that came with 

the printer and reinstalled the 

printer driver from the CD. It 

worked and I can print over my 

home network using a wireless 

connection again. I have no idea 

why this happened but at least 

one other TAPCUG member 

also discovered a printer driver 

problem after installing Vista 

SP1. 

 

Speaking of security (see para-

graph 1), Windows Vista, like 

Windows XP, comes with a fire-

wall program pre-installed. As 

all you computer gurus know, a 

computer firewall is a hardware 

or software tool that examines 

all Internet traffic letting only 

―safe‖ traffic into your com-

puter. The firewall for Vista was 

supposed to scan Internet traffic 

both entering and leaving your 

computer. I can hear some of 

you saying, ―If I scan incoming 

traffic to be safe, why do I care 

about outbound traffic?‖ Well, 

incoming traffic is the bigger 

threat to you. Using pre-defined 

rules it determines which pro-

grams are allowed to use your 

network connection or which 

ports can be used for communi-

cations. If some spyware, Tro-

jans or malicious ―phone home‖ 

software slips past your firewall, 

they may allow someone to take 

remote control of your computer 

to attack it or other computers 

through your Internet connection 

(that's why Microsoft is always 

sending you those security up-

dates). So a firewall that scans 

outbound traffic attempts to stop 

this. To make a longer story 

short, contrary to plans, the abil-

ity to check outbound traffic has 

not been provided with Vista's 

firewall. 

 

Another shortcoming of Vista's 

firewall is that it does not create 

a log of all attempts to contact 

your computer from a local net-

work or the Internet. This kind 

of record can be useful if you 

suspect a hacker has been visit-

ing your computer in the middle 

of the night. Actually, there is a 

way that you can modify Vista's 

firewall to create a log and ex-

amine outbound traffic. The 

process to set this up is probably 

more complicated than most of 

us would like to deal with so I 

offer a much easier solution. 

Turn off Vista's firewall and in-

stall a third party firewall pro-

gram. Do not try to use two or 

more firewall programs at the 

same time. They do not play 

well together. There are a num-

ber of firewall programs that 

you can purchase as well as  

(See Vista-Part 9, page 8) 

 

Moving on to Vista — Part 9 
by Neil Stahfest  

Tacoma Area PC User Group, WA 
www.tapcug.org 

ncstahfest@msn.com 

Article 
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If you're wondering when you 

should turn off your personal 

computer for energy savings, 

here are some general guidelines 

to help you make that decision. 

 

Though there is a small surge in 

energy when a computer starts 

up, this small amount of energy 

is still less than the energy used 

when a computer is running for 

long periods of time. For energy 

savings and convenience, con-

sider turning off: 

 

     • the monitor if you aren't  

 going to use your PC for   

 more than 20 minutes 

 • both the CPU and monitor 

 if you're not going to use 

 your PC for more than two 

 hours. 

 

Make sure your monitors, print-

ers, and other accessories are on 

a power strip/surge protector. 

When this equipment is not in 

use for extended periods, turn off 

the switch on the power strip to 

prevent them from drawing 

power even when shut off. If you 

don't use a power strip, unplug 

extra equipment when it's not in 

use. 

 

Most PCs reach the end of their 

―useful‖ life due to advances in 

technology long before the ef-

fects of being switched on and 

off multiple times have a      

negative impact on their service 

life. The less time a PC is on, the 

longer it will ―last.‖ PCs also 

produce heat, so turning them off 

reduces building cooling loads.  

 

For cost effectiveness, you also 

need to consider how much your 

time is worth.  

 

If it takes a long time to shut 

down the computer and then re-

start it later, the value of your 

time will probably be much 

greater than the value of the 

amount of electricity you will 

save by turning off the computer. 

 

Power-Down  or  

Sleep Mode Features 

 

Many PCs available today come 

with a power-down or sleep 

mode feature for the CPU and 

monitor. ENERGY STAR® 

computers power down to a sleep 

mode that consume 15 Watts or 

less power, which is around 70% 

less electricity than a computer 

without power management fea-

tures.  

 

ENERGY STAR monitors have 

the capability to power down into 

two successive ―sleep‖ modes.  

 

In the first, the monitor energy 

consumption is less than or equal 

to 15 Watts, and in the second, 

power consumption reduces to 8 

Watts, which is less than 10% of 

its operating power consumption. 

 

Make sure you have the power-

down feature set up on your PC 

through your operating system 

software. This has to be done by 

you, otherwise the PC will not 

power down. If your PC and 

monitor do not have power-down 

features, and even if they do, fol-

low the guidelines below about 

when to turn the CPU and moni-

tor off. 

 

Note: Screen savers are not en-

ergy savers. Using a screen saver 

may in fact use more energy than 

not using one and the power-

down feature may not work if 

you have a screen saver acti-

vated. In fact, modern LCD color 

monitors do not need screen sav-

ers at all. 

 

When to Turn Off  Personal Computers 
U.S. Department of Energy 

Energy Efficiency and Renewable Energy.  

A Consumer's Guide to Energy Efficiency and Renewable Energy 
www.energy.gov/forconsumers.htm 

Article 

 

Frozen in Action 
 

If you're photographing sports or 

other kinetic activities, you can 

use extremes of shutter speed to 

accentuate the action. A slow 

speed (1/15th of a second, for 

example) will lead to blurring of 

the figure, emphasizing its sense 

of motion. With fast shutter 

speeds, you can stop action, 

such as capturing a high-jumper 

hanging weightless while clear-

ing the bar. 
From Smart Computing 

Tip 



CLASSIFIED ADS 

Members may place personal ads of three (3) lines for 

free. All other business and non-members ads: $2.00 

per ad for 3 lines. Ads must be prepaid, camera-ready 

copy, and received by the 15th of the month preceding 

publication. 
 

ADVERTISING RATES 

GS-BUG accepts commercial advertising from mem-

bers and outside businesses at the following rates: 

 Business Cards (3 1/2‖ x 2‖) ......... $15.00 

 Page Ad ......................................... $25.00 

 1/2 Page Ad ................................... $35.00 

 Full Page Ad .................................... 60.00 

All prices are for single issue only. All advertisements 

must be prepaid and received by the 15th of the month 

preceding publication. All artwork must be camera 

ready copy. 

 

Checks payable to GS-BUG, Inc. 

Mail to: 

GS-BUG, Inc.—Advertising 

3623 W. 227th St.,  

Torrance, CA 90505-2522 
 

LIBRARY  

Shareware disks are available at the General Meeting 

for $3.00 per disk and $5.00 per CD. Charges are to 

recover duplication and distribution costs. 

SIG MEETINGS 
 

Daytime Hardware   Every Tuesday 

1—4 Torrance Scout Center 

Bob Hudak  rsh532@aol.com 

 

Digital Imaging   Every Tuesday 

9—12 noon Torrance Scout Center 

Greg Neumann  Gbug_caller@aol.com 

 

Linux  2nd Thursday 

7:00 p.m. Garry Sexton‘s 

George Porter  310-373-5416 

   g19porter@verizon.net 

 

Beginning Windows XP  3rd Thursday 

7:00 p.m. Garry Sexton‘s 

Virginia Pfiffner  310-374-2410 

   vpfiffne@elcamino.edu 

 

Internet  4th Thursday 

7:00 p.m. Garry Sexton‘s  

Tom Tucknott           310-530-4992  
 ttucknott@socal.rr.com 

SIG Meeting Addresses 
Torrance Scout Center 

2375 Plaza Del Amo, Torrance 

   Garry Sexton’s 

    3623 W. 227th St., Torrance 

GS-BUG Membership Application 
 

[    ] New         [    ] Renewal       [    ] Update 

 
I hereby apply for membership in the Greater South Bay PC Users Group. I understand I will be entitled to at-

tend meetings, receive the monthly newsletter and be eligible for special offers that become available from time 

to time. 

 

 

Name (Please Print)    First    Last 
 

 

Address 

 

 

City, State, Zip +4 

 

 

Phone     E-Mail 
 

Individual $36.00; Student $18.00; Family $48.00; Newsletter Subscription $18.00 

 

Please mail check to: GS-BUG, Inc.—Membership; 241 Via Los Miradores, Redondo Beach, CA 90277-6761 



The Bug Report 
The Greater South Bay PC Users Group 

3623 W. 227th St. 

Torrance,  CA 90505 

Sunday Monday Tuesday Wednesday Thursday Friday Saturday 

   1 

 

2 3 4 

5 6 

General  

Meeting 

 7  SIG Meetings 

Digital Imaging 

Daytime 

Hardware 

8 

Board 

Meeting 

9 

SIG Meeting 

Linux 

10 11 

Newsletter 

Deadline 

12 

Columbus 

Day 

13 

Columbus 

Day—observed 

14  SIG Meetings 

Digital Imaging 

Daytime 

Hardware 

15 

 

16  

SIG Meeting 
Windows XP 

17 18 

 

19 20 21 SIG Meetings 

Digital Imaging 

Daytime 

Hardware 

22 23 SIG Meeting 

Internet 
24 25 

26 

Daylight  

Savings Time 

Ends 

27 

 

28 SIG Meetings 

Digital Imaging 

Daytime 

Hardware 

29 30 31 

Halloween 
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